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Software License

© 2010 Fiberworks
Computer software is protected by copyright.  Your purchase of the software grants you license to use the
software under the terms described below.

1) You have been assigned a registered user number with your purchase.  This user number appears on
the printed invoice sent to you by Fiberworks, and on the program CD if the software was delivered on CD.
Keep this number accessible: it may be required if you need technical help, for future upgrades or if you
transfer ownership.

2) Fiberworks is not liable for any damage in consequence of use of this software.  Liability is limited to
refund of the purchase price only in event of dissatisfaction with the performance of the software. 

3) You may install the software on any and all computers that you own, and use the software for your
personal use only.  Use of the software installed on computers that you own by another individual on an
occasional and non-lasting basis is also accepted under these terms. 

4) Each copy of the software must be validated by entering a code obtainable from Fiberworks.  These
codes are unique to each computer that the software is installed on.

5) Your valid registration gives you the right to purchase upgrades to the software at a price lower than for
purchase of a new copy.  By upgrading, you relinquish rights to the previous version.  If you upgrade to a
new version, you may not sell or otherwise transfer license to use the software to another user without
relinquishing your own license and registered user number.  "Transfer" of the software includes transfer of
a CD containing a current or superseded version of the software, transfer or sale of a computer with an
active copy of the current or superseded software on the hard disk, or any other means of electronic
duplication of the software that makes it available to another user.

6) In the event that you intend to cease use of the software altogether, you may transfer your registration to
another user by sale or gift.  Fiberworks should be notified of the transfer of registration so that the new
user can gain upgrade rights. The user relinquishing the registration then ceases to have further rights to
use or upgrade the software.

7) In the event of abuse of these terms, Fiberworks reserves the right to revoke a registered user number.

8) Your continued use of the software implies your acceptance of these terms.

Please abide by the spirit of good craftsmanship and do not copy this program.  We work very hard to give
you the best software we can.

You may freely distribute any unvalidated copies of Fiberworks PCW that function only in Demo mode.    If
you need brochures or advertising material for your friends or weaving students, we will be happy to send
them to you.

Bob Keates and Ingrid Boesel  Fiberworks PCW

PO Box 649, Ganges

Salt Spring Island, BC  V8K 2W2

Canada
Email: info@fiberworks-pcw.com

Website:http://www.fiberworks-pcw.com
Manual creation date: 2010/03/15
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Validation of 4.1/4.2 Silver Plus

For installation of the PCW4.1/4.2 Silver Plus program, see the main Silver Manual

Validation dialog for activating loom functions 
This validation dialog may appear
when you choose File>Weave in a
copy of Fiberworks that was previously
validated as Silver rather than Silver
Plus. It may also appear in Silver Plus
if you select an AVL loom in Loom
Setup, but your original validation did
not include AVL.

It allows you to upgrade your current
Silver version to Silver Plus or Silver
Plus with AVL without having to
reinstall the program.  

If you installed and validated as Silver
Plus or Silver Plus with AVL originally,
you should not encounter this dialog. 

Copy the program ID numbers from
your computer screen. The numbers
in the illustration above are just an example.  This is not your program ID!

Follow the instructions on the dialog and email the program ID to us at:

info@fiberworks-pcw.com

In addition to the program ID, please identify yourself with name, program purchase
registration number or invoice number or date of purchase, and indicate if you are
validating regular Silver Plus or Silver Plus with AVL.

We will send back the Validation code by email as soon as possible, often the same day.

Enter the validation code into the 4 white boxes, without leading zeros, and without
leading or trailing spaces. You can navigate from box to box with the Tab key, or by
mouse.

Use the activate button to complete the validation process. Until you validate you can’t
access the weaving features described in this manual 

Validation for AVL includes all other looms.

If you have different looms connected to different computers, each computer generates a
unique Program ID (even if they were all installed from the same CD) and each needs its
own validation code. There are no extra charges for a reasonable number of replacement
codes.

FIBERWORKS 4.1/4.2 SILVER PLUS
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Designing to Weave

Before opening the weaving window, create a design or open an existing file in the
normal drawdown window.  Shown below is a variation of maltese.dtx, one of the sample
designs included with the 4.1 Silver Plus program.

The design may have a conventional tieup and treadling or it can be a liftplan as shown.

Number of shafts should not exceed the capacity of your loom. 

To proceed to the Weave function go to File>Weave in the main menu.

If the Weave item on the File menu is grayed out, check that there is a weaving design
open in the drawdown window, with at least one pick. If it’s still grayed out, you may
need to validate the program to activate the weave functions. If the entire program has
not been validated, Save and Print items in the File menu will also be greyed out. See
your Fiberworks Silver manual for information on how to validate.

When you first enter the Weaving window, the title bar will say no loom selected. While
the program is in this state, you can simulate loom action by pressing the spacebar.
One press is equivalent to opening the shed, and a second press is equivalent to
throwing the shuttle and closing the shed.  The simulation will allow you to explore the
weaving window functions before getting involved with the loom itself.

FIBERWORKS 4.1/4.2 SILVER PLUS
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Weaving Window Layout:

The weaving window shows
your design in three different
views. 

The upper left panel shows
a color view of the cloth.
The upper right panel
shows a structure view of
the same portion of your
design, which may be a
warp drawdown or a weft
drawdown according to your
preferences. In a warp
drawdown, warp over weft is
represented by black
squares. 

The pick order is bottom
up, which is inverted from
the drawdown design
window, but will show the
cloth the way it should
appear as you weave.

The lower edge of these
panels shows one pick
detached.  This represents
the pick you are about to
weave.  Everything above
this line is a preview of what you are about to weave

The bottom part of the window is occupied by the lag chain. Each row represents one
pick, and lists the shafts that will be lifted. Pick number is in the leftmost column, and the
rightmost column shows the color for that pick according to your weaving draft. Pick
number 1 is highlit in light blue.  This indicates that it is the next pick to be woven.

The bottom right corner of the main Fiberworks window frame contains status
information. From left to right this is: magnification of the cloth views, the number of
picks woven, the number of warp ends visible in the cloth views, and the weaving
status, currently STARTUP.

FIBERWORKS 4.1/4.2 SILVER PLUS
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Press the spacebar. In the No loom selected state, this simulates the action of the loom.
The first press changes the weaving status from STARTUP to READY. Press spacebar
again; the second press changes the status to OPEN. On a real loom this means that the
shed is open and you can throw the shuttle. Press a third time to close the shed; status
becomes  READY, the blue bar advances to pick 2,
and the detached thread drops to the bottom of the
cloth windows, indicating that it is now beaten in at
the fell.  Press the spacebar several more times.

As simulated weaving progresses, the blue bar marking the current pick moves up. By
current pick, we mean the pick about to be woven in the shed closed state (status
READY) and the pick being lifted in the shed open state.  When the blue bar reaches the
middle of the lag chain, the lag chain will start to scroll down so that the current pick
remains centered. 

The detached thread in the cloth panels also represents the current pick.  When you
close the shed, this drops down and adds to the fell, and the next thread detaches from
the preview to become the current pick  From the fell downwards represents a history of
what has been woven already.  Everything above the fell is a preview of what you are
about to weave.  When the current pick reaches the middle of the cloth panels, the cloth
drawdowns scroll downwards as well so that the current pick remains centered.

FIBERWORKS 4.1/4.2 SILVER PLUS
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Changing the Size of the Weaving Window Panels
The relative size of the
different panels in the
weaving window can be
easily changed by using the
mouse.  Rest the mouse
cursor on the border. The
cursor will change into a
double headed arrow when
you hit the exact boundary.

Drag the border in direction
needed to resize the panel. 

In the example on the right,
the weaver has chosen to
see more  interlacement
than structure drawdown,
and more cloth than lag
chain.  You can make either
the cloth color or structure
panels disappear altogether.
The lag chain can be
reduced to just the current
pick if you so choose. 

If you decrease the width of
the entire weaving window,
the numbers of the shafts in the bottom, lag frame become smaller and more crowded.  

At extremely small frame sizes, the highest numbers can no longer be displayed.  This
varies with resolution and font settings on the display controls for your monitor and video
card and the number of shafts on your weaving design. When weaving with 32 or 40
shafts, you may have to use a maximized Fiberworks window and a maximized weaving
window.

Liftplan and Lag Chain
The term Lag refers to the wooden or metal bars used to select shafts on a mechanical
dobby loom.  Pegs screwed into the bars determine which shafts are lifted on each pick.
The lag chain is series of lags linked together in sequence.  In Fiberworks, the lag chain
represents the sequence of picks which determine the weaving.  There’s a subtle
difference from the liftplan: the lag chain may take specific sections of the liftplan (p.14),
may repeat (p.15) or may reverse the pick order of the liftplan (p.16); picks from the
liftplan can alternate with tabby that is omitted from the original liftplan (p.15). 

FIBERWORKS 4.1/4.2 SILVER PLUS
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File Menu (weaving window)

Open    keyboard: Ctrl + O toolbar

This opens dtx or wif files the weaving Window. A new
weaving will start at pick 1. A design that was woven and
saved previously as a dtx file will resume at the last
woven pick if the design was saved on the previous exit.  

Close  
This closes the weaving window. If the design is also open
in a drawdown window, the drawdown window remains
open, otherwise you may be prompted to save the file.

Save keyboard: Ctrl + S toolbar
Save As

These save the currently active design. If you save as a dtx file, the last pick woven and
current weaving state will be included in the file, so that you can resume exactly where
you left off when you reopen the file.  Wif files do not include weaving information. Use
Save As to change the filename or folder location when you save, so that you do not
overwrite the original. For a design originally opened as a wif file, you may wish to use
Save As to save a dtx version of the file so that the current weaving state is recorded.

Note: The program assumes that if you open a shed, you also threw the shuttle, so the
last open shed counts as the last pick woven.  If you open the shed, and quit without
throwing the shuttle, you will be one pick too far ahead when you resume. See Unweave
(p.17) and Navigating in the lag chain (p.8-9) to see how to correct this situation. 

Loom Setup see next page for details.

Program AVL Cartridge 
This loads the current design into the memory cartridge which is available as an option
for the AVL Compu-Dobby I or Compu-Dobby II (p.26).

Drawdown keyboard shortcut: Ctrl+D

This brings the drawdown window for your current design to the front and activates that
window.  If the current design is not open in a drawdown window, a new window is
opened.  Use this menu item if you need to make major adjustments to the design.

See also: Sequence>Reset Chain, p.12. 

Exit
This closes the whole Fiberworks program, including the weaving window, any open
drawdown windows and any sketchpad windows. For each unsaved design, a prompt will
appear asking if you wish to save before the program finally closes down. 

FIBERWORKS 4.1/4.2 SILVER PLUS
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Selecting up your Loom
Use the menu items Loom 1 Setup and Loom 2
Setup to select and configure one or two looms
connected to your computer.  The looms
supported* are listed below right.

When you have selected your loom, you will
need to set the Com number for the port.
Fiberworks scans for available ports, and lists
them.  If you know the Com number, select it
from the list.  Otherwise see pp.19-21,36-38,
Finding and troubleshooting ports.

Then set the maximum number of shafts for the
loom.

Some looms have optional settings:

For ARM 

Try the setting with and without the check mark: see
which works best for you.

For  Toika

Toika uses the Scandinavian convention that shaft 1
is furthest from the weaver, at the back of the loom.
By default, Fiberworks  reverses the shaft order so that shaft 1 appears to be at the
front of the loom.  If you thread your loom Scandinavian style, shaft 1 at the back, put a
check mark in the box, otherwise leave it blank.

For AVL, click the Options button. It has been known (rarely) that the magnetic or optical
arm sensors have been installed inverted.  If the
Weaving status says OPEN when your shed is
closed, and READY when the shed is open, put a
check mark in the box to correct the problem.  On
CDIII, you can also choose whether to activate
solenoids late (when shed is closed) or to activate
them early (when shed is open).  Experiment to
find what is best for you.  Fast weavers should
probably take the early (shed open) option. 

When you have selected your loom and made Com and options settings, close the dialog
and go to Diagnostics > Response Test (p.18) to check that communications are
working.

* Fiberworks no longer supports LIPS or Combby looms in version 4.2 because the
programming for the parallel port used by these looms is not compatible with Windows
XP and later.  For a solution for J-COMP looms, contact lampas@mindspring.com.

FIBERWORKS 4.1/4.2 SILVER PLUS
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Edit menu (weaving window)

The Edit menu contains important items relating to editing
and navigating the lag chain.

Undo    keyboard shortcut Ctrl+Ztoolbar

This menu item reverses any editing function you may have
carried out.  To correct a weaving action, see Unweave in
the Sequence menu, (p.17).

Edit Lag Chain  keyboard shortcut: Ctrl+D toolbar  inactive

active

This menu items puts directional arrow keys in Navigating mode when it is inactive.
This is the normal safe setting that limits unintended modification of your design while
you are weaving. There is no check mark next to the menu item and the toolbar button
appears popped out. Click the button or select the menu item to permit active editing: a
check mark should appear next to the menu item and the toolbar button will appear to be
pushed in.

Navigating by keyboard

The up arrow key 
advances the Preview portion
of the lag chain. The down
arrow key  lets you move
back up.

PgUp and PgDn jump in steps
of 20 picks. The woven
portion won’t move - what’s
already woven is woven and
won’t change just because
you move to a new part of the lag chain. If the shed is still closed, the current pick is
considered to be part of the preview.  If shed is already open, the shaft selection can’t
change and the current pick won’t move.  For most looms, it’s recommended to navigate
and make adjustments when shed is closed.  

If you open and close a shed without throwing the shuttle, the pattern advances because
the computer can’t tell that no weft was inserted. You can use the down arrow key to
back up to the missed pick.

Left and right arrow keys shift the portion of the threading that is used to draw the cloth
panels in the upper part of the weaving window. This does not affect the lag chain or
anything that you weave, just what you see in the cloth panels. Home and end jump 20
warp threads right or left respectively.

See also Sequence > Go to Lag, p.13.

FIBERWORKS 4.1/4.2 SILVER PLUS
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Navigating by mouse
If you move the mouse cursor over the
preview section, either in the upper
cloth panels (upper panels) or in the
pick number column of the lag chain,
the pointer or pencil cursor changes into
a hand. Click and drag: the hand points
its index finger at the selected pick.  You
can drag this pick up or down to reposition the lag chain.  The woven part of the cloth
and chain panels will not change: they represent a history of what is already woven.  In
the cloth preview, you can drag from side to side as well as up and down.  This brings
different parts of the threading into the preview.

If the shed is closed (status is READY), the current pick is still part of the preview.
When shed is open, the current pick is now fixed in place. For most looms it’s good
practice only to move the lag chain when shed is closed.

See also View > Vertical Scrollbar, p.11. 

Editing by keyboard“

Click the Edit Lag Chain toolbar button or select the menu item to make editing active.

A blinking horizontal bar appears in one of the picks
in the preview part of the lag chain; this indicates
the active insertion point. The woven part of the
lag chain is grayed out, indicating that it can’t be
edited.  The cursor arrow keys let you move the
insertion point within the editable area and to scroll
to other parts of the lag chain.

Type + at the insertion point to make that shaft lift. 

Type − on a shaft number at the insertion point to
stop that shaft from lifting.

Type any number. This is entered into the pick
containing the insertion point.  If a shaft is already
marked as lifted, typing that number erases it.  If the
shaft is not marked, typing the number marks it to
be lifted, so it toggles that shaft number on and off.

Editing by mouse
The mouse cursor takes the form of a pencil when it is
in the preview area of the lag chain. Click on a dash
symbol to make the corresponding shaft lift.  Double
click on a shaft number to stop it from lifting.  You can
also click new colors into the weft color column.

The mouse cursor is a pointer in the area already woven, indicating that you can’t edit.

FIBERWORKS 4.1/4.2 SILVER PLUS
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The remaining two menu items require an insertion point, so they are inactive when
Edit Lag Chain is inactive. To get an insertion point in the intended pick:

Either select Edit Lag Chain, then when the insertion point appears, use the cursor
arrow keys to move it to the right spot.

Or simply click the mouse pencil cursor on a shaft in the intended pick that’s already
marked as being lifted.

Remember you can only edit the preview region, not the woven part of the lag chain.

Insert Pick keyboard shortcut: Ins toolbar:

This and the next item are only active in Edit Lag Chain mode. This menu item,
keystroke or toolbar click inserts a blank pick at the insertion point.  The blank pick can
then be edited as you please.  Use this to add extra picks to your liftplan “on the fly” so
that you can add extra features in your weaving such as inlay or pickup.  

Delete Pick keyboard shortcut: Del toolbar:

This menu item, keystroke or toolbar click deletes the pick at the insertion point.

When you have finished editing, click Edit Lag Chain back to inactive again to protect
your liftplan from unintended modification and restore normal navigation.

View Menu (weaving window)

These menu items control various aspects of the
appearance of the weaving window. 

Zoom in shortcut: Alt + toolbar:

Zoom out shortcut: Alt - toolbar:

These items control the magnification of the color and
structure views of the cloth in the upper panels. They do not
affect the magnification of the lag chain.  If you resize the
whole weaving window smaller, the shaft numbers squeeze
together and eventually switch to a smaller font size.

See p. 5 for how to change the amount of space given to lag
chain and cloth views.

Flip Warp
This option lets you set left to right or right to left threading order for the cloth views.
It’s up to you to ensure that the threading on the loom and the display match.

FIBERWORKS 4.1/4.2 SILVER PLUS
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Change Face
Use this menu item to weave with the opposite face of the
cloth upwards. When you select Change Face, shafts that
were previously unlifted are now lifted and vice versa.

If your original design was unbalanced and was set to lift
more than half the shafts, you can use Change Face so that
you lift fewer shafts while weaving.  You can also use
Change Face if one face of your cloth is susceptible to
damage such abrasion of floats, and would be better protected the other way up.

Be careful about using change face if your design has asymmetric elements that
should not be reversed. You can Flip Warp on the screen, but that won’t correct anything
if your loom is already threaded. 

Back View 
This menu item lets you inspect the back face of the cloth on the computer screen
without changing the way you actually weave it.  Strictly speaking, what you see is the
mirror image of the back of the cloth unless you also flip the warp. 

Horizontal Scroll Bar, Vertical Scroll Bar
The horizontal scroll bar menu item lets you put a scroll bar across the bottom of the
weaving window.  This lets you scroll to different parts of the threading into view in the
cloth display panels and does not affect the weaving sequence.  The vertical scroll bar
menu item puts a scroll bar on the right side of the weaving window. This lets you scroll
quickly to different points in the liftplan, altering the preview portion of the cloth panels
and lag chain. Use this cautiously, since it changes the sequence of picks to be woven.

Toolbar 
This menu item lets you hide or show (default) the toolbar.

Cloth Menu (weaving window)

These menu items let you select the display modes for
the two cloth panels at the top of the weaving window.

Interlacement is the most generally useful for weaving.
Although some of the other modes show particular
styles of weaving more accurately, they can be
confusing when you want to see how each thread is
placed.

Warp drawdown shows warp over weft as black and
weft over warp as white. Weft drawdown shows weft
over warp as black and warp over weft as white.

FIBERWORKS 4.1/4.2 SILVER PLUS
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Sequence Menu

This menu controls how you progress through the lag chain
and other factors affecting events while weaving. 

Endless Loop

Autoreverse toolbar

Halt at End
These three menu items determine what happens when
you reach the end of your liftplan, and one member of the
three is always selected, indicated by a check mark in the
menu and a pressed in look to the selected button.

The default is to make an endless loop. The last pick in
your liftplan is followed by the first pick and the entire
liftplan sequence repeats without limit. Watch out for
liftplans that have top to bottom symmetry: if the last pick
is identical to the first pick, there will be a pair of identical
picks at the transition point.  Either delete the identical last
pick, or see Set Range for another way to deal with this.

Autoreverse means that when you reach the last pick in
the liftplan, the direction of weaving reverses, and you
work backwards through the chain.  When you reach the
first pick of the lift plan, the direction of progress reverts to forwards again.

Halt at end puts blank picks (marked M:) after the last pick in your liftplan.

Reset Chain
This menu item clears out the
past history of your weaving
session allowing you to start a
fresh session from scratch.

A rather alarming warning
appears when you select this menu item: don’t use it as a quick shortcut to get back to
pick 1, but there are times when you do need to Reset the chain to its starting point.
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Reset chain, continued

When you start a weaving session, Fiberworks records how many picks have been
woven, your current position in the liftplan and the current direction of progress.  In
addition, there’s a history of the last 64 picks woven. This information is stored in your file
if you save after ending each weaving session, and allows you to resume where you left
off in the next weaving session. 

The lag chain always has a designated start point and end point in your liftplan. By
default  the start is pick 1 and the end is the last pick, but the Set Range menu item
described on p.14 allows you to start and end using only part of your complete liftplan.

Minor edits of the liftplan done in the drawdown window that alter the pattern but not the
total number of picks are automatically picked up by the weaving window.  Major edits of
the liftplan done in the drawdown window that alter the total number of picks will
require Reset Chain so that the weaving window can use the altered liftplan properly.

If you add or remove a few picks using the Insert Pick and Delete Pick from the Edit
menu (p.10), the weaving window keeps track and does not need a reset.

Go To Lag keyboard Ctrl+G toolbar:

Use this menu item to move to a specific lag or pick
number the chain.  If you have a very long chain, the
slider moves around quickly; for fine control, use the
spin buttons or just type a number in the box.

Set Beeps
Use this menu item to set visible
and audible marks in the lag
chain that you can use as alerts.
The default is every 20 picks.
For a visible alert, every
twentieth pick appears with red
rather than black text.

For an audible alert, you can set
one of the standard Windows
alerts to sound every 20 picks.
Click the Test button to listen to
the alert to see if it is suitable.
For this to work, your computer must have speakers and have sound enabled.  Check the
Windows Control Panel > Sounds to ensure sounds are enabled.

Alternative prompt points include:

Beep whenever a particular color appears in the weft color sequence.

Beep on every color change (don’t use this if you are alternating colors every pick!)

Beep on markers that you can set in the lag chain. Click on the Set marker button.
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Set beeps, continued

This dialog allows
you to set specific
markers  in the
liftplan to sound
an alert when the
marked point is
reached. The
dialog shows
drawdown on
the left and
liftplan on the
right.  Marks are
placed in the
divider that
separates drawdown and liftplan.  Either click with the mouse to place a mark (click
again to erase), or move the blinking insertion point with the up and down arrow keys and
type S to set a mark and U to unmark. You can scroll to mark other parts of the liftplan
that are currently off-screen.

Set Range 

This dialog is
very similar to the
dialog above, and
allows you to
select a limited
part of the
liftplan to act as
the current lag
chain.  You can
mark a start
point and an end
point anywhere
in the liftplan, and
these will be used
as the limits for
Endless Loop or
Autoreverse.

The limits are marked by the red arrowheads in the divider that separates drawdown
and liftplan. The red line indicates the range that will be woven

When the mouse cursor rest on an arrowhead, it becomes a hand symbol. You can now
click and drag the arrowhead to a new position.
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Pattern Only keyboard Ctrl+P

Autotabby keyboard Ctrl+A
toolbar

Tabby only keyboard Ctrl+T

These three menu items determine the tabby content
of your lag chain.  One member of the three is always
selected, and this is indicated by a check mark placed
next to the selected menu item, and a pushed in look
to the corresponding toolbar button.

In Pattern only mode, every pick in the lag chain
comes from successive picks in the liftplan, with no
tabby (unless there was tabby in the original liftplan).

In Autotabby mode, tabby picks alternate with
pattern picks taken from the liftplan. Tabby picks are
marked A: and B:. If tabby was included in the
original liftplan, both liftplan tabby and autotabby
will appear. Autotabby does not add tabby to the
original liftplan and you can’t remove tabby from the
original liftplan by switching from Autotabby back to
Pattern; instead use Weft > Remove Tabby in the
Drawdown window, and then do Reset Chain. 

In Tabby only mode, only tabby picks are woven.

Tabby Setup toolbar

This menu item and dialog gives you control over the tabby or ground weave structure,
and allows for more complex ground weave structures than simple plain weave. The grid
can be 2,3 or 4 picks deep, depending on the ground weave selected.  Initially, the grid
contains two simple tabby picks, which are determined by analyzing your threading. You
are free to edit the tabby grid as you please by clicking the mouse or by typing.
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Tabby setup continued

The lower half of the dialog lets you set colors and thicknesses for the
tabby threads, and to choose a sequence for inserting tabby and pattern in
the Autotabby mode. The default sequence for simple tabby is AxBx, where
A and B represent the two tabby picks and x represents pattern picks taken in
the order that they appear in the original liftplan. 

If your ground weave is all one color and thickness, click the Set All button, otherwise
you need to set the color and thickness for each pick in the tabby sequence.  The default
thickness of 4 units is the thickness of a normal thread in Fiberworks.

Step Tabby keyboard: Ctrl+B toolbar

Step tabby switches the positions of the A and B tabby picks in the Autotabby mode. If
you are using a three- or four-pick twill type ground weave, it steps through the pick
sequence of the ground weave.

Reverse Direction keyboard: Ctrl+R toolbar

Select this menu item or click its toolbar button to reverse the lag chain and progress
backwards through the liftplan sequence.  If the liftplan sequence is already reversed,
the lag chain will revert to forward progression.  Only the preview section of the lag
chain is rebuilt. This includes the current pick while shed is closed, but not if shed is
open. In the illustration, a red asterisk marks the turning point of the pattern. You  
should select Reverse Direction immediately after the turning point has been woven.
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Unweave keyboard: Ctrl+U          toolbar

Select this menu item, or type Ctrl+U,
or click its toolbar button to work back
through the lag chain’s history of what
has been woven already, so that you
can correct an error in a previous
pick. Click the button or type Ctrl+U
again to revert to normal Weaving. 

How  Unweave differs from Reverse

If you select Unweave after weaving
pick 59, the current pick will be pick 59
again so you can remove the weft

If you select Reverse after weaving
pick 59, the current pick will be pick 58.
The turning point of the pattern is not
repeated.

After you remove weft 59 and close the
shed in Unweave mode, the current
pick moves back down the list of picks
already woven so that you can remove
successive wefts until you reach the
error. The preview section does not
change direction.

When you Reverse direction, the
already woven section continues to
accumulate picks, and picks run in
descending in the preview section.
Compare the illustration on this page with p.16.

Solenoid power off keyboard: Enter toolbar

Release All (AVL CD III only)

Select Solenoid power off to rest the solenoids in your dobby head by turning power off
to the solenoids while leaving the dobby box itself powered up.  Use this option whenever
you are taking more than a couple of minutes break to avoid any risk of overheating. For
most looms, you can also use this option when you want to lift nothing, e.g. for loom
maintenance.

Use Solenoid Power Off on the AVL Compu-Dobby III to rest the solenoids as
described above. However with solenoids off, the Compu-Dobby III lifts all shafts. For
the Compu-Dobby III, the additional menu item Release All releases all shafts by
sending power to all solenoids.  Use this menu item sparingly to avoid overheating
and don’t leave it on for more than a few minutes.
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Diagnostic Menu

This menu allows you to check aspects of your loom’s function, in
particular, communication with the loom.  Not all looms use all of
the functions in this menu, and specific details for each type of
loom are given in the Looms  section.

Response Test  
This menu item test two way communications. The computer
sends a query, and the loom sends a response.  If the response is
detected, you will get the message 

Loom X responding OK!
If this test fails, the left hand end of the status line will say 

Switch Loom X on now if it’s not on yet!

Treadle Sensor Test
This test detects signals sent by the loom when the treadle is moved up and down. Run
this test if the pattern does not advance when you treadle the loom. For AVL looms, this
is a test of communication from loom to computer.  Other looms use two way
communication.

Test Left Dobby Unit On a loom with two dobby control units, this sends
diagnostic tests to the left hand unit, otherwise tests go to the right hand unit.

Solenoid Test
This tests communication from computer to loom and checks that solenoids respond
properly. If the pattern is empty, click Fill Pattern to set all the odd-numbered solenoids.
Click Activate Solenoids to send the pattern to the loom and check that they respond.

If you click Fill Pattern again, it will invert the pattern to set all the even shafts, or you
can click or double-click individual squares in the grid to turn them on and off in any
pattern you like. Click Solenoids off when you are done.   

Button Test, Alignment        See the AVL section, p.24.

Port Test
This tests whether the currently selected port can be opened by Windows. See also
Finding and Troubleshooting Ports, pp.19-21,36-38.
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Finding Ports

All the looms currently supported in Fiberworks
Silver Plus use a RS232 serial interface, commonly
known as a serial port, although in some cases this
is hidden behind a built-in USB adapter. This means
that the port is identified by a Com number e.g.
Com1, Com5 etc.  To establish communications with
the loom, you need to know which Com number the
loom is using.  This is entered in the Loom Setup
dialog. 

Using built in serial ports on your computer

The standard serial port connector is typically a nine
pin D-shape.  The socket on the computer has pins,
and the socket on the loom has holes.  On very old
computers and some older looms, you may encounter
sockets with 25 pins.  If you don’t have a vintage cable,
25-pin to 9-pin adapters for these variants can be
obtained at larger computer stores. 

Since the advent of Windows XP, new computers
frequently do not have serial ports.  In some cases
the chips that control the serial port are installed, but
there’s no external socket to connect to.  If that’s the
case, the least expensive solution is a USB to RS-232
Serial adapter.

Note: The 25 pin socket with holes on many
computers is a parallel or printer port. You
can’t connect the loom via the printer port.

Using USB to serial adapters
These have a USB plug at one end that goes into the computer and serial connector at
the other end that goes into the loom. These are available at most large computer stores.
If the cable is short, you can add a USB extender cable to reach the computer end.

Looms that have USB sockets have the USB to serial adapter built in, and can use a
standard USB cable.

All USB to serial adapters, including those built in to the loom, need to have a driver
installed, otherwise Windows won’t recognize them.  The driver is usually provided on
a CD than comes with the adapter, or you may have to go to the manufacturer’s website
to download the driver. Drivers may be specific for a particular Windows version. If you
have Windows Seven or Vista, make sure that your adapter has the appropriate driver.

Keep the CD accessible in case you have to reinstall the driver.  If you don’t have it or
can’t get the driver by download, the only solution is to purchase a new adapter.
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Finding your Com number 
To help you find your Com port, Fiberworks scans for all available Com
numbers up to Com9, and lists them in the Port type box in the loom setup
dialog.  If it’s not in this list, the port is not available to use.

If the list is blank:

You may not have a port and you need to add a USB Serial adapter.

You may have the serial socket, but the port is disabled internally. It’s probably
cheaper to get a USB to serial adapter than to have a computer tech fix the port.

You may have the adapter, but the driver is not properly installed.

Another program may be using the port; ports can’t be shared by two programs.

However, just because ports are listed does not mean they are truly available. For the
scan illustrated above, the computer has an internal chip for Com1 but it’s not
connected to a socket that you can plug into. This is a common situation for computers
less than 6 years old, or laptops less than 8 years old.

On this computer, Com3 is a modem, not a serial port.
Of the 3 Com numbers listed for this particular computer, the only one suitable for
connecting a loom is  Com5, a USB-serial adapter.

Typically, built in serial ports are Com1 or Com2.  Modems may be Com1 to Com 4.
Polite modems do not override an existing serial port’s Com number, but cases are
known where a modem takes over Com1 and disables the actual serial port.

USB-Serial adapters typically take higher Com numbers, starting at Com3 or Com 5.  To
identify a USB-serial adapter  Com number, do the following.

1) Unplug the USB-Serial adapter from the computer and open the Loom Setup dialog.
Check the list of Com numbers and note down those that are listed.

2) Close the dialog, plug in the USB-Serial adapter, and reopen the Loom Setup Dialog.
This makes it repeat the scan for ports.  You should see an additional Com number in
the list.  This is the USB-serial adapter’s Com number.

See also the Portchecker (p.36-38) for detecting and identifying ports.

Check communications with the loom
Once you think you know the Com number for your port, select that port in the Loom
Setup Dialog, go to the Diagnostics menu and try the Solenoid Test and the Response
Test. Com setup is done automatically by Fiberworks to match the loom you have
selected.  There is no need to set baud rate etc. manually. The Solenoid test establishes
whether computer to loom communications are proceeding.  The response test checks
for two-way communication between loom and computer. If there are problems, use the
Portchecker  to test and troubleshoot loom communications directly without going  
through a weaving program (p.36-38). Additional details and possible solutions are given
in that section.
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Troubleshooting Ports

This section assumes that you have 

selected the right loom; the selected loom is
identified in the title bar of the weaving window.
identified and selected the right port; this is
reported at the left end of the status bar.  Verify this
by trying Diagnostics>Port Test.
made sure that the dobby control box on the loom is
switched on and the cable linking it to the computer is
connected. This may sound obvious, but sometimes
the obvious is missed!

Start by trying the response test (diagnostics menu).
The message shown on the right indicates a
successful response test. The computer is talking
to the loom and the loom is replying.

If the Response Test Fails
If no reply is received, the message below right
shows at the left end of the status bar.  This could
mean that there’s no communication in either
direction, or that the computer is talking to the
loom but no reply has been received.

Next try the solenoid test (p.18). If the solenoids respond as expected, the computer is
talking to the loom OK, but not receiving a reply.

Some antivirus software intercepts data entering the computer via serial ports, and
does not pass the data on quickly enough to allow you to weave. If you need virus
protection, McAfee, Trend Micro, and Avast are antivirus programs that don’t hinder
loom communication, but consider uninstalling all antivirus programs if the loom
computer is never connected to the internet. 
Try disconnecting and reconnecting the serial cable.  This has been known to
rejuvenate a weak connection.
If you can lay your hands on a different serial cable, try that.

If the solenoid test does not work, there is no communication in either direction.

Does the Com number you have selected belong to a modem, not a serial port?
Make sure that the cable you are using is not a NULL MODEM cable.
It’s possible that the socket on the computer that you plugged into is disabled.

Com settings are done automatically by Fiberworks to match the loom you have selected.
There is no need to set baud rate and so on manually.

The least-fuss solution to serial port problems may be to add a USB-serial adapter.

See also the Portchecker, p.36-38.
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Looms
AVL Compu-Dobby series

Power on
If you switch power on to the AVL Compu-Dobby before
entering the weaving window, Fiberworks should detect it
immediately, assuming communications are established.
This is reported at the left end of the status bar.
If the AVL Compu-Dobby is not powered up when
you open the weaving window, you will first see
the reminder to switch on. When you switch on  
the Compu-Dobby, it starts an internal test which activates each solenoid in turn, and you
should hear the regular clicking sound.  At the end of the self test, it signals the computer
that it is ready, and it should then report that it is responding OK on the status bar.

Important: On AVL Compu-Dobby I and Compu-Dobby II, do not press any buttons
on the control box until the computer has communicated with the loom by sending the
first pick to the solenoids, or by doing the Response Test or Solenoid test.  If you
press a control box button before the computer has communicated with the loom, the
Compu-Dobby goes into Cartridge mode, and ignores all further signals from the
computer.  To get out of cartridge mode, turn the power off to the Compu-Dobby, wait
five seconds, and turn it on again. 

Starting to weave
Initially, the word STARTUP appears at the right end of the status bar.  The computer is
waiting for an indication that you are ready to weave.  On the Compu-Dobby I and II, do
this by pressing each treadle in turn. Nothing lifts on the first cycle, because solenoids
are still inactive.  The next time the lifting treadle is down, you should hear the solenoids
click on.  Push the release treadle to complete the cycle, and the next time you press the
lifting treadle, shafts will lift and open the shed. When you are into the weaving cycle,
solenoids should click each time the shed is fully open in readiness for the next pick.

You can follow the same procedure on the Compu-Dobby III, with the disadvantage that
with solenoids inactive, you have to lift all shafts.  Do this if you can put up with the effort
required. The alternative is to press the Enter key to signal you are ready to weave; this
will make the computer send the first solenoid data to the loom.  When you do loom setup
for the CD III, you can choose to have solenoids activate when shed is open (better for a
fast weaver) or when shed is closed (less heating of the solenoids).

If you leave the loom for any significant period of time, click the Solenoids Off button or
press the Enter key to rest the solenoids and avoid overheating.  Use the startup
procedure described above or press Enter again to resume weaving.

FIBERWORKS 4.1/4.2 SILVER PLUS

22 © 2010, Fiberworks



Navigating the lag chain
It is recommended that you do all adjustments of position or direction of the liftplan in the
shed closed position.  If you change position in the liftplan with cursor arrow keys or by
scrolling or dragging the mouse in the weaving window (p.8-9), solenoids will click in
rapid succession.  This can be avoided by selecting Solenoids Off while doing major
adjustments.  Follow the start up procedures described previously  to resume weaving.

Diagnostics
Response test checks communication.  If the
loom receives the test, solenoids will start
clicking one by one.  The Compu-Dobby also
clicks its solenoids when you first turn on power
to the unit. Do the Response test after you
power up the Compu-Dobby and it has
completed its self-test so you can be sure that
the Compu-Dobby is responding to the
computer. When the solenoids finish clicking,
the Compu-Dobby signals to the computer, and
the message above right should display. 

Treadle Sensor test detects the signals that
the Compu-Dobby sends to the computer when
the arm that picks the shafts reaches its upper
position (shed fully closed, release treadle
down) and when it reaches the lower position
(shed fully open, lifting treadle down).
Normally the lifting treadle is on the right and
the release treadle is on the left, but treadles
can be connected either way without affecting
how the loom performs.

The dialog that appears when you select Treadle Sensor test from the diagnostics menu
indicates when these signals are received by putting checkmarks in the boxes.  Push
each treadle a few times until the box labelled test has passed shows a check mark.

If the test reports arm up when it’s actually down and arm down when it’s actually up,
click the switch positions button to correct this.  The loom will seem to function with the
wrong orientation, but may occasionally skip a shaft or two because of the bad  timing.

Sensor error detected indicates a possible electronics fault.  Ignore it if it occurs once in
a blue moon, but you may need to consult AVL if errors are detected frequently.

The Compu-Dobby I uses optical sensors embedded in a plywood square bolted on
just below the dobby box. These need steady ambient light to work properly. A bright light
directly overhead from the sensors can cause them either to not detect the arm
movement, or to detect both positions simultaneously, which triggers the sensor error
response.  Extraneous shadows, bright sunlight or reflections passing over the
sensors can also set off spurious signals that mimic arm movement.
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Solenoid test  (p.18) tests communication from computer to loom.  If this test succeeds
and the response test does not, it indicates that there’s something stopping the computer
from receiving signals from the loom, but otherwise the Com number of the selected port
is correct.

You can use the Solenoid test to check individual solenoids. Click the Clear Pattern
button, then set solenoids on one at a time by clicking into the grid pattern. Treadle the
loom to see that the selected shaft picks up and releases cleanly.

Button Test checks the response of the AVL button
controls.  These are found on Compu-Dobby I on a box at
the end of an extension cable.  On the Compu-Dobby II,
they are on the control unit that is mounted in the middle
of the loom.  The Compu-Dobby III does not have button
controls.  Button controls are designed primarily to
operate the Compu-Dobby with the memory cartridge, but
weaving programs can also respond to them.  To test,
press each button once to put check marks in each box
and repeat to uncheck each box. Watch out for check
marks that flicker on and off as you press the button.

In weaving mode (rather than button test mode) the buttons do the following

1) Skip advances the pattern by one pick (similar to the cursor up arrow key).

2) Reverse switches the liftplan direction of progression (similar to Sequence>Reverse).

3) Pattern selects Pattern Only mode (p.15).

4) Tabby selects Tabby only mode (p.15).

5) Save stores the current weaving position in when weaving from the memory
Cartridge. When weaving in Fiberworks, it sets unweave mode.

6) Resume restarts a weaving session from the memory Cartridge.  When weaving from
Fiberworks, it turns solenoids off to rest them and turns them back on to resume.
Don’t use Resume to start a session with Fiberworks before the first Pick has been
sent to the Compu-Dobby.  Doing so will put the Compu-Dobby into Cartridge mode
and block communication from the computer (p.22).

Alignment activates your first and last solenoids (assuming you have selected the right
number of shafts in Loom Setup).  Use Alignment when you mount the Compu-Dobby I or
Compu-Dobby II solenoid box on the loom.  Refer to the AVL manual for assembling the
Compu-Dobby on the loom for instructions on how to set the alignment correctly.

Alignment should be a two person job. Your assistant should hold the box in place so
it does not crash to the floor. Loosen the bolts that mount the Compu-Dobby solenoid
unit on the side of the loom (on the Compu-Dobby II, not the control unit in the middle of
the loom). Position the unit so the extended solenoids displace the shaft wires enough to
push them into the slots in the arm mechanism, but not so tight that the “piano keys”
resist the extended solenoid tips. Now tighten the bolts.  Check bolts periodically to
ensure that they remain tight so that the Compu-Dobby does not slip out of its brackets.
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If the Compu-Dobby does not lift all the shafts selected
Make sure the shaft cables have not slipped off a pulley in the castle

If you use the air-assist, make sure the piston is adjusted to bring the arm back to the
topmost position.

On the Compu-Dobby III, the solenoid tips  have little stirrups to guide the shaft
cables.  Check to see that cables have not slipped out of the stirrups. 

Check the how the shaft cables line up with the slots in the arm. If you live in a region
with large seasonal changes in humidity, the mounting strut (CD I and II) may shift.

If the Compu-Dobby continues to lift shafts that were selected on the previous pick
Although it seems that you can close the shed by releasing the lifting treadle and
relying on gravity alone, a distinct push on the release treadle is needed to ensure
that the arm rises to the topmost position so that the shaft cables can slip out of the
slots on the arm.  If you don’t do this, some cables may stick in place.

If you have set solenoids to activate when shed is closed on the Compu-Dobby III, go
to loom setup and set it to activate solenoids when shed is open.

If the treadle needs excessive force to open the shed

The cable from the lifting treadle should wind around a snail-shaped cam. Check that
the cable has not slipped off this cam.

Check the tension on the shaft-balancing springs.

If one of the solenoids does not activate
Your Compu-Dobby box may need to go on a California vacation.  Consult AVL.

Do make sure that lint does not accumulate around the cooling fan and louvres.

Do not ever use lubricant on the solenoids. 
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Programming the AVL Cartridge
This option on the File menu allows you to put designs into the AVL cartridge to allow you
to continue to weave with the computer disconnected. You can load the design that’s
currently in the weaving window into the cartridge.  When you Select this menu item, the
contents of the cartridge are uploaded to the computer, which takes about a minute.

A) shows the name of
the current design and
the number of lags used.

Click Add to cartridge
to store the Fiberworks
design in the cartridge.

Click Autotabby to add
tabby insert tabby into
the design to be loaded.
There are no autotabby
controls on the cartridge,
so tabby must be
preloaded.

B) Current tabby picks.

C) Preview of the liftplan.

D) Summary of space used and space available in the cartridge

E) List of designs in the cartridge

F) Button controls

Undo All undoes any changes you have made in this session.

Clear All empties the current contents of the cartridge

View item puts an item in the cartridge into the preview window C.

Delete item deletes a single item in the cartridge.

Retrieve item brings a liftplan from the cartridge into the weaving window. This is not
recommended as an alternative to saving designs as files on your computer, but you can
retrieve to do minor editing if needed. The cartridge does not store threadings or colors,
so a retrieved liftplan may not match the current threading in the weaving window.

Click OK when done.  It takes about a minute to download the revised contents back to
the cartridge.

Note: CompuDobby I cartridges run off an internal rechargeable battery which over time
loses the ability to hold a charge.  If the battery won’t charge, then the cartridge
forgets everything as soon as the power is turned off.  If the battery has leaked
and corroded the electronics, the cartridge may be a lost cause.
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Louet Magic Dobby, Megado and Octado series

Ports
If you connect the Louet Dobby via the USB cable, this links to a built in USB to serial
adapter. Driver software for built in or external USB to serial adapters is not included in
any version of Windows (unlike memory sticks, cameras and MP3  players). 

To use the built in USB adapter, you need to install a driver provided by Louet
(downloaded from their website) so that Windows can identify the port. If you use an
external adapter to link to the serial port, you need to use a driver from the manufacturer
of the adapter, usually provided on a CD when you purchase the adapter, but sometimes
downloaded from the manufacturer’s website.  You should ensure that the driver is
compatible with your version of Windows. Don’t bother upgrading to Windows 7 in the
hope that the drivers are finally included - they are not.  Keep any CD with this driver
software on hand in case you have to reinstall or if you transfer to a new computer.

Power on
If you switch power on to the Louet Dobby before
entering the weaving window, Fiberworks should detect
it immediately, assuming that communications are
established.  The response is reported at the left end of
the status bar.
If the Louet Dobby is not powered up when you
open the weaving window, you will first see the
reminder to switch on. When you switch on  the
Louet Dobby, it sends a sign-on message to the computer to indicate that it is ready, and
the computer should then report that Louet loom is responding OK.

Starting to weave
Initially, the word STARTUP appears at the right end of the status bar.  The computer is
waiting for an indication that you are ready to weave.  On most Louet looms, you can do
this by pressing the treadle gently and returning to the rest position.  It’s not
necessary to press all the way down.  On the Magic Dobby without a treadle, push the
handle down a few inches and then return. The solenoids should activate when you
return to the rest position of the treadle or handle. In a few cases, this may not work and
you should push the Enter key to fire the solenoids for the first pick.

Weaving Cycle
Solenoids are normally activated just as the shed closes, and deactivated as the shed
reaches the fully open position.  If you leave the treadle in the rest position for any length
of time, the solenoids remain under power and risk  overheating.  It’s a good idea to use
the Solenoids off menu item or toolbar button (Sequence menu) whenever you intend to
take a break. Resume weaving as described for Starting to weave.
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Timed out
To prevent overheating, the
solenoids in the Louet dobbies turn themselves off if the shed is not opened within
about 60 seconds of the solenoid being activated.  If this happens, the computer may
beep and the Status bar indicates TIMED OUT in the Weaving Status section. Resume
weaving after being TIMED OUT as described for Starting to weave.

Navigating the lag chain
If you can reach your computer easily from the weaving position, you can do adjustments
of position or editing in the liftplan in the shed open position while solenoids are normally
off. Changes will affect the next pick.  If solenoids do not automatically activate when you
close the shed, press Enter to resume weaving.

If it’s hard to keep the treadles pressed while working at the computer, you can also do
adjustments of position or editing in the liftplan in the shed closed position.  If you
change position in the liftplan with cursor arrow keys or by scrolling or dragging the
mouse in the weaving window (p.8-9), changes affect the current pick and solenoids will
click in rapid succession.  This can be avoided by selecting Solenoids Off while doing
major adjustments.  Follow the start up procedures described previously  to resume
weaving.  Minor adjustments (one or two steps) such as reversing the sequence or
switching to tabby can be done in the shed closed position with solenoids on.  

Diagnostics
Response test checks two way communication
between computer and loom. The computer
sends a query and waits for a response.  When
this is received the message on the right should
display. If no response is received, the reminder
message below remains displayed at the left end
of the status bar.

Treadle Sensor test detects the signals that the
Louet Megado or Octado send to the computer
as the knife moves from its upper position
(shed fully closed, treadle up) and as the shed
is halfway open. Louet looms use a magnet on
the knife and two sensor switches mounted on
a wooden strut that projects from the dobby
box. The upper switch is placed so the magnet
triggers it at or near the shed closed position.
The lower switch is roughly midway between
shed closed and shed fully open positions, so
the magnet passes by the switch very briefly.
To do the treadle sensor test, it’s advisable to
move the treadle steadily and relatively slowly rather than a normal weaving treadle
action, so as to catch the instant when the magnet is next to the lower switch.
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Treadle sensor test on the Magic Dobby: On the Magic Dobby, the knife that picks the
shafts raises shafts instead of pulling down on cords, but otherwise the principle is the
same.

Switch 1 should respond when the handle is almost all the way down, shafts raised

Switch 2 should respond when the handle is all the way up, shafts down.

Solenoid test  (p.18) tests communication from computer to loom.  If this test succeeds
and the response test does not, it indicates that there’s something stopping the computer
from receiving signals from the loom, but otherwise the Com number of the selected port
is correct. You can use the Solenoid test to check individual solenoids. Click the Clear
Pattern button, then set solenoids on one at a time by clicking into the grid pattern.
Treadle the loom to see that the selected shaft picks up and releases cleanly.

There are no button controls to test on the Louet dobby units, and no Alignment test.

If the Louet Dobby does not lift  the shafts selected
If the weaver dithers or presses the treadle tentatively, the solenoids may release
before the knife has caught all the “piano keys” that lift the shafts.  Typically, this
causes lower numbered shafts to be missed.  To prevent this, the weave needs to
treadle more briskly.

If the magnet is set too high or the knife set too low, solenoids may release too early
and miss lower numbered shafts.

If the cord to the treadle is too tight so the knife is too low, or the magnet is set too
high, the knife may pass higher numbered shafts before it can pick them up.

If shafts from the previous pick are lifted when they are not selected

Check for sticky shafts that don’t drop back to their proper unlifted position. When
this happens, the “piano keys” that the solenoids push out don’t return to their unlifted
position, and stick in a pushed out position (see step 4 above). When the knife
descends for the next pick, it catches the piano key even when the corresponding
solenoid is not activated.
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What makes shafts stick?
Insufficient tension on the warp. Increase warp tension as
much as reasonable, and use weighted shaft bars (available
from Louet) rather than plain wooden shaft bars.

Shaft cords have slipped out of the slots at the end of the
wooden shaft bars - see cord 2 in the illustration on the right.

Bowed shaft bars. The metal reinforcement in the weighted
shaft bars corrects this. 

Heddles too crowded and bunched together, especially
bunches of unused heddles Spread your heddles as much as
possible, and stagger the placement of unused heddles at the
ends of shafts. 

If the treadle needs excessive force to open the shed
Check that cords have not slipped of their pulleys, in particular the large wooden
pulleys below the dobby head.

Check that lint and stray thread have not accumulated on the pulley bearings, in
particular, the wooden pulleys below the dobby head.

If one of the solenoids does not activate when it should
Use Solenoid Test to check the dobby unit when it’s dismounted from the loom.
Consult Louet if a solenoid appears not to respond properly.

On the Magic Dobby, make sure that the plastic “piano keys” line up with the solenoid
tips and a solenoid is not pushing between “keys”.
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Leclerc Diana, Weavebird and Voyageur series looms 

Power on
If you switch power on to the Leclerc Dobby before entering the weaving window,
Fiberworks should detect it immediately, assuming that communications are established.
The response is reported at the left end of the status bar.
If the Leclerc Dobby is not powered up when you
open the weaving window, you will first see the
reminder to switch on. When you switch on  the
Leclerc Dobby, it sends a sign-on message to the
computer to indicate that it is ready, and the computer should then report that it is
responding OK.

Starting to weave
Initially, the word STARTUP appears at the right end of the status bar.  The computer is
waiting for an indication that you are ready to weave. Press Enter to fire the solenoids for
the first pick.

Weaving Cycle
Solenoids normally activate just as the shed closes, and deactivate as the shed reaches
fully open. If you leave the treadle in the closed position for any length of time, solenoids
remain under power and risk overheating.  Use the Solenoids off menu item or toolbar
button (Sequence menu) whenever you intend to take a break. Resume weaving by
pressing the Enter key.

Timed out
To prevent overheating, the solenoids in the Leclerc dobbies turn themselves off if the
shed is not opened within about 60 seconds of the solenoid being activated.  If this
happens, the computer may beep and the Status bar shows TIMED OUT in the Weaving
Status section. Resume weaving after being TIMED OUT by pressing the Enter key.

Navigating the lag chain
If you can reach your computer easily from the weaving position, you can do adjustments
of position or editing in the liftplan in the shed open position while solenoids are normally
off. Changes will affect the next pick.  If solenoids do not automatically activate when you
close the shed, press Enter to resume weaving.  If it’s hard to keep the treadles pressed
while working at the computer, you can also do adjustments of position or editing in the
liftplan in the shed closed position.  If you change position in the liftplan with cursor
arrow keys or by scrolling or dragging the mouse in the weaving window (p.8-9), changes
affect the current pick and solenoids will click in rapid succession.  This can be avoided
by selecting Solenoids Off while doing major adjustments.  Press Enter to resume
weaving.  Minor adjustments (one or two steps) such as reversing the sequence or
switching to tabby can be done in the shed closed position with solenoids on.
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Diagnostics
Response test checks two way communication
between computer and loom. The computer
sends a query and waits for a response.  When
this is received the message on the right should
display. If no response is received, the reminder
to switch on remains displayed at the left end of
the status bar.

Solenoid test  (p.18) tests communication from computer to loom.  If this test succeeds
and the response test does not, it indicates that there’s something stopping the computer
from receiving signals from the loom, but otherwise the Com number of the selected port
is correct. You can use the Solenoid test to check individual solenoids. Click the Clear
Pattern button, then set solenoids on one at a time by clicking into the grid pattern.
Treadle the loom to see that the selected shaft picks up and releases cleanly.

Treadle Sensor test detects the signals that
the Leclerc Weavebird or Diana and related
Leclerc dobby looms send to the computer as
the treadle is moved from shed closed, treadle
up to shed open position. To do the treadle
sensor test, it’s best to move the treadle
steadily and relatively slowly rather than a
normal weaving treadle action, so as to catch
the instant when the magnet is next to each  
sensor.

Macomber and Dobbytron series Looms

Power on
It is recommended that you should switch on
power to the Dobbytron or Macomber after
entering the weaving window. When the
Macomber is detected, a prompt appears.

Starting to weave
Initially, the word STARTUP appears at the right end of the status bar.  The computer is
waiting for an indication that you are ready to weave. Press Enter to fire the solenoids for
the first pick.
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Weaving Cycle
Solenoids are normally activated just as the shed closes, and deactivated as the shed
reaches the fully open position.  If you leave the treadle in the rest position for any length
of time, the solenoids remain under power and risk overheating.  It’s a good idea to use
the Solenoids off menu item or toolbar button (Sequence menu) whenever you intend to
take a break. Resume weaving by pressing the Enter key.
Navigating the lag chain

Do adjustments of position or editing in the liftplan in the shed closed position.  If you
change position in the liftplan with cursor arrow keys or by scrolling or dragging the
mouse in the weaving window (p.8-9), changes affect the current pick and solenoids will
click in rapid succession.  This can be avoided by selecting Solenoids Off while doing
major adjustments.  Press Enter to resume weaving.  Minor adjustments (one or two
steps) such as reversing the sequence or switching to tabby can be done in the shed
closed position with solenoids on.

Diagnostics
Response test checks two way communication between computer and loom. The
computer sends a query and waits for a response (see Power On).  

Solenoid test  (p.18) tests communication from computer to loom.  If this test succeeds
and the response test does not, it indicates that there’s something stopping the computer
from receiving signals from the loom, but otherwise the Com number of the selected port
is correct. You can use the Solenoid test to check individual solenoids. Click the Clear
Pattern button, then set solenoids on one at a time by clicking into the grid pattern.
Treadle the loom to see that the selected shaft picks up and releases cleanly.

There is no Treadle sensor test for the Macomber.

Toika

Power on and Starting to Weave
You can switch power on to the Toika
before or after entering the weaving
Window.  However, Fiberworks can’t
detect whether the Toika is powered up.
Instead a prompt box appears. 

Click the OK button only when the
Toika is connected and switched on.
Your response will start the weaving cycle
by sending the first pick to the loom.
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Shaft order on the Toika
By default, the Toika uses Scandinavian shaft
order, that is Shaft 1 is at the back of the loom.
When you do Loom Setup and select the Toika,
you can choose whether to place Shaft 1 in
front (leave the checkbox unmarked) or adhere
to the Scandinavian convention and keep shaft 1
at the back (click on the checkbox to place a tick
mark in it).  Always thread the loom according
to the convention you have chosen.

Weaving cycle
Solenoids are normally activated just as the shed closes, and deactivated as the shed
reaches the fully open position.  If you leave the treadle in the rest position for any length
of time, the solenoids remain under power and risk overheating.  It’s a good idea to use
the Solenoids off menu item or toolbar button (Sequence menu) whenever you intend to
take a break. Resume weaving by pressing the Enter key.

Diagnostics
There is no response test for the Toika. Use Solenoid and Treadles Sensor tests instead.

Solenoid test  (p.18) checks communication from computer to loom.  If this test
succeeds and the treadles sensor test does not, this means that there’s something
stopping the computer from receiving signals from the loom, but otherwise the Com
number of the selected port is correct. You can use the Solenoid test to check individual
solenoids. Click the Clear Pattern button, then set solenoids one at a time by clicking
into the grid pattern. Treadle the loom to see that the selected shaft picks up and
releases cleanly.

Treadle Sensor Test checks communication from loom to computer, in particular the
signal that tells the computer to advance the pattern. A switch on the control box of the
loom determines whether to progress though the liftplan forwards or in reverse. If
communications are good, when you treadle the loom, one of the following messages is
posted, depending on the position of this switch.

The reverse switch on the loom duplicates the action of the Reverse Direction menu
item and toolbar button.  The computer can track changes in switch setting on the loom,
but the loom does not know when you use the toolbar Reverse button.  To avoid
confusion, be consistent in which method you use.
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Arm Selectronic 

Power on
You can switch power on to the ARM  
Selectronic before or after entering the
weaving Window. Only click the OK in the
reminder box after power is switched on to
the loom control unit. Fiberworks then sends
the loom a message to activate the
computer controlled mode.

Starting to Weave
To signal that you are ready, push the treadles in turn. The first cycle may be a blank
pick, but solenoids should activate the next time shed is closed. When you hear the
solenoids click, open the shed without delay.

Time out
To prevent overheating, the solenoids in the Arm dobby head turn themselves off if the
shed is not opened within five second of  the solenoids being activated.  If this happens,
the computer may beep and the Status bar shows TIMED OUT in the Weaving Status
section. Resume weaving after being TIMED OUT by pushing treadles in turn until the
solenoids reactivate.

Diagnostics
Response test:  A message should appear indicating that the ARM is responding. If The
loom seems to stop clicking solenoids at any time, for example after a time-out or after
the treadle sensor test, and does not respond to pushing the treadles, doing the response
test will reactivate the computer controlled mode.

There is no solenoid test for the ARM. To test solenoids, make up a simple pattern that
lifts one shaft at a time as well as any other pattern you need to check such as tabby, and
open the pattern in the weaving window.

Treadle Sensor Test checks communication
from loom to computer, in particular the signal
that tells the computer to advance the pattern.
After doing this test, push the treadles in turn to
resume weaving.
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Portchecker

Portchecker is an accessory program installed with Fiberworks that allows you to check
and monitor communication with your loom.  You can find Portchecker in the Start Menu:
go to Programs>Fiberworks>Fiberworks Silver Plus 4200>Portchecker.  Portcheck
helps you identify the correct port and lets you see the messages that pass between
loom and computer.

Step 1: Portchecker scans for available ports up to Com9; the scan can distinguish
between normal serial ports and modems, so Com3 is identified as a modem. 

To identify the Com number of a USB-serial adapter,  remove the
adapter  and click Scan Again.  One of the Active ports should
become NOT available. Plug the adapter back in, wait 20 seconds  
and scan again.  The same port should become an Active port once
again.  Use this Com number when you do Loom Setup in Fiberworks (p.7).

For Louet looms with a built-in USB adapter, connect the cable and turn on power to
the dobby. Scan and note down Active ports, unplug the cable, and scan again to see
which port becomes NOT available. Use this Com number for the Louet loom.
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Step 2: Select the port by clicking a dot into the button in
front of  the Com number.  Select the loom from the list,
and turn on the power to the loom. For looms that do a
self-test, wait until it settles down, then click Check Loom.

If the port was correctly selected, a response should appear
in Data Received and Message Received boxes. To get a
response from the Toika, you must treadle the loom.

Data received shows the actual codes sent back by the
dobby unit.  Message received translates this data into
English.  For the AVL Compu-Dobby, Check loom will
initiate a self-test that causes solenoids to click in turn. If the
self test starts after doing Check Loom, but no response is
received, something is interfering with data arriving at the
computer from the loom. 

Step 3:  Set a pattern to test solenoid activation. The default is all odd shafts, but you can
create other patterns by clicking check marks on or off in the boxes. There are only 16
boxes, so shafts 17-32 echo the setting for shafts 1-16, and likewise for shafts 33-40.
Click Solenoids off before quitting. 

Step 4:  Try pushing the treadles: the example here is for AVL Compu-Dobby.  For Louet
and Leclerc, you need to set solenoids before pushing the treadle.
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Troubleshooting with Portchecker

The port you want to use is reported as NOT available
Ports can’t be shared between two programs open at the same time. Other software
may have claimed the port.  Examples:

The software for linking a person digital assistant such as a Palm Pilot.

The driver that comes with an uninterruptible power supply (UPS).  This driver is
designed to shut down an unattended computer when power is lost.  If your computer
is not routinely unattended, you do not need to install this driver.

A driver for a serial mouse, never uninstalled when the mouse died. 

Fiberworks: close down all weaving windows while you are using Portchecker. Close
down Portchecker when you try to weave with Fiberworks. 

Although a socket exists for the port, it may not be connected internally, or the port
may be disabled in the computer’s BIOS settings.  If you are not familiar with adjusting
your BIOS Setup, this may be something to leave to an outside expert, or buy a
USB-serial adapter, which is probably less expensive than hiring outside help.

Do not mistake your printer port (a socket with 25 holes to fit a cable with 25 pins) for a
serial port .

The USB-serial adapter keeps changing its Com number
This may happen if the USB adapter is sometimes plugged in when you turn on power to
the computer, and sometimes plugged in after Windows is up and running. The adapter is
being identified at different stages of Windows start up. Be consistent:: either always
plug in before turning power on or always plug in after Windows is up.

No new Active port appears when the USB adapter is plugged in
Make sure that the driver that comes with the adapter is properly installed.

Make sure that the supplied driver is compatible with your version of Windows, in
particular Vista and Seven. If you can identify the manufacturer of the adapter, go to their
website and see if there’s a driver available to download.

There’s no response from the loom
If it’s an AVL Compu-Dobby I or Compu-Dobby II, did you touched any buttons on the
control unit after turning the power on?  The Compu-Dobby may be in cartridge
mode and not listening to the computer. Turn the Compu-Dobby off, wait five
seconds, and turn it on again.  Wait until solenoids stop clicking before trying to
communicate again using the Check loom button.

Uninstall or disable Norton Antivirus if you have it on your computer. 

Make sure you are not plugged into a parallel or printer port.
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No response from loom, continued

Cable problems
Serial cables come in two flavours, but only one is suitable for connecting a loom.

A standard RS-232 serial cable is intended to link a computer to an external device such
as a camera, a modem, a printer or a loom dobby unit. 

A null modem cable is designed to link two computers together.

Two computers have their serial sockets wired the
same way.  If a standard cable is used to connect
two computers together other, the pins that talk on
each computer connect to each other, and likewise
the pins that listen connect. The result is no
communication.  The null modem cable corrects
this by crossing the wires in between.  Now the
left talker connects to the right listener and the right
talker connects to the left listener.

External devices such as dobby units wire their
sockets the opposite way to computers, so a
standard cable connects talk to listen in both
directions.  In this case, a null modem cable
connects talk to talk and listen to listen - hence
no communication.

A typical null modem cable has identical connecters
at each end while a standard cable usually has male at one end and female at the other.
Inspect your cable. If the cable itself has identical connecters at each end but is made to
fit the loom with an extra adapter, it may be the wrong type.

Using Windows Device Manager to explore your ports 
Find Device Manager by opening the Control panel (Start > Settings > Control Panel).

Click on the System Icon, and then select Device Manager.
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Using Windows Device Manager (continued)

Device manager (left) lists all the hardware on your computer. Expand Ports COM &
LPT to show the list of Com ports.  Modems, if present, are listed separately.  Click open
the Com Port you wish to inspect to show its Properties dialog.  The General Tab will
indicate if a Port is disabled. There is no need to change Port settings here: Fiberworks
automatically makes the right Port Settings for a given loom.  

Click on the Advanced Button. The Advanced setting dialog lets you change the Com
number of a port.  Do this if a modem and a usable Com port conflict with each other.
Try putting a lower setting on the Receive buffer if you are having erratic reception of
signals from the loom.
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